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Support

Please visit the HP OpenView web site at:

www.hp.com/managementsoftware 

There you will find contact information and details about the products, services, and support that HP 
OpenView offers.

You can go directly to the support web site at:

http://support.openview.hp.com/ 

The support web site includes:

• Downloadable documentation

• Troubleshooting information

• Patches and updates

• Problem reporting

• Training information

• Support program information
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Introduction
The purpose of this book is to help you identify error conditions, locate the source of the 
error conditions, and then specify the actions to take to rectify the error conditions. The  
troubleshooting process involves the following activities, among others:

• finding information about the problem in the log files

• identifying the symptoms of the problem

• identifying possible solutions

First Things First

Some report-related problems are relatively easy to solve. The following is a list of things 
to check before you go any further. 

• Is trendtimer running? 

If trendtimer is not running, start it. See the Performance Insight Reference Guide for 
more information about the trendtimer command.

• Are the appropriate datapipes installed?

Check the User Guide for the relevant report pack to determine which datapipes must 
be installed.
9



Introduction
• If you have a new OVPI installation, and the Interface Reporting reports have no data, 
make sure that both the IFEntry_Disc_Datapipe and the 
Interface_Reporting_ifEntry_Datapipe are installed.
10
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Where to Start?
When you begin to troubleshoot an OVPI problem, two steps are essential:

1 Describe the problem in terms of the visible symptoms, for example, “The XYZ 
Report has no data in it.” Write down all the symptoms, and be as specific as possible.

2 Gather information from the relevant OVPI logs.

This chapter describes the front end and back end logs that may contain important 
information related to the problem.

About Debugging and OVPI Logs

When everything is working well, you should not need to enable debugging. (In fact, it 
could reduce performance.) But when there is a problem with an application or the 
application server, the debugging messages may give you a clue as to where the problem 
lies.

When sending logs to HP Technical Support or to OVPI Development, always ensure that 
debugging was enabled in those logs and that you have reproduced the problem so that it 
shows in the logs.
11



Where to Start?
Debugging with OVPI Commands

For information about debug settings when you are using OVPI commands, see the 
Performance Insight Reference Guide. Refer to the section on the specific command you 
were using when the problem occurred.

Debugging with OVPI Clients

To turn on debugging when you are using one of the OVPI clients (Management Console, 
Report Builder, or Report Viewer), do the following:

1 From the Edit menu, select Options.

2 On the Logging tab, click the Enable Logging and Enable debug tracing check 
boxes.

3 Click OK.

Debugging with the Web Access Server

To turn on debugging when you are using the Web Access Server, do the following:

1 On the home page of the Web Access Server, click Administration on the Links bar.

2 In the Administration tree, expand the Service Configuration folder.

3 Select Web Access Server.

4 Do one of the following:

• If the Enable Debugging check box is not checked, click the box to make a check 
mark. Then click Apply. Go to Step 5.

• If the Enable Debugging check box is checked, exit this web page. No further 
action is necessary.

5 If you placed a check mark in the Enable Debugging check box, you must stop and 
restart the Web Access Server for the change to take effect.

For more information about changing settings for services, see the Performance Insight 
Administration Guide.
12
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Debugging Procedure

Follow these steps for best debugging results:

1 Start with an empty log file. If the problem is associated with running a client (such as 
the Management Console), first close the client, then rename the appropriate log file.  
A new log file will be created when you restart the client.

2 Turn on the logging and debug options, as described above in Debugging with OVPI 
Clients or in the Performance Insight Reference Guide (for OVPI commands).

3 Reproduce the problem.

4 View the log file to analyze the problem.

Checking Log Files

Check log files for any entries that relate to the problem. All of the log files described in 
this chapter are located in $DPIPE_HOME/log/. You can find more detailed 
information about viewing and interpreting log files in the Performance Insight 
Adminstration Guide.

You may want to use an application such as Microsoft® WordPad or Excel to help you 
sort the output and find the information you want. For example, if you use Excel, follow 
these steps:

1 Save the log file with a name that ends in “.csv”.

2 Open the file in Excel.

3 Sort on the Status column, searching for the words “ERROR”, “INFO”, and 
“WARNING”.

4 Analyze the problem messages.
13



Where to Start?
Front End (OVPI Client) Logs

Each front end client application has its own log file. The front end log file names are:

• builder.log

• console.log

• viewer.log

Most OVPI front end log files use a common, comma-separated-value (csv) format with 
the following layout: 

builder.log

This log contains informational, warning, error, and debug messages from the Report 
Builder application.

Debugging must be turned on (see Debugging with OVPI Clients on page 12) for debug 
messages to appear in the log. Enabling debugging also causes SQL queries and other 
more detailed information to appear in the log.

console.log

This log contains informational, warning, error, and debug messages from the OVPI 
Management Console application. 

timestamp A fixed format of the time the log entry occurred

time zone The local system time zone as reported by the OSGMT

offset The offset from the GMT

application name The application reporting this message to the log

module The functional module in the application

severity INFO, WARNING, ERROR, or DEBUG

process ID The OS process ID of the application

thread ID The thread ID (or parent process ID) as reported by the OS

message ID The internal message identifier, if available 

log message The actual text message of the log incident
14
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Debugging must be turned on (see Debugging with OVPI Clients on page 12) for debug 
messages to appear in the log. Enabling debugging also causes SQL queries and other 
more detailed information to appear in the log.

viewer.log

This log contains informational, warning, error, and debug messages from the Report 
Viewer application.

Debugging must be turned on (see Debugging with OVPI Clients on page 12) for debug 
messages to appear in the log. Enabling debugging also causes SQL queries and other 
more detailed information to appear in the log.

Back End Logs

The log file names for the back end applications are:

• audit.log

• dbmaint.log

• install.log

• metrics.log

• report.log

• trend.log

• website.log

audit.log

This log contains start/stop information for back end processes. It can provide a good 
overview of performance.

The log includes 10 comma-delimited fields:

• dtsys001 or dtsys002 — 1 = start, 2 = stop

• Executable (or Module) — The actual process that is running

• Process ID — The process ID of the process

• Parent Process ID — Parent of this process

• Start Date
15
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• Start Time

• End Date

• End Time

• Run Time (in seconds)

• Parameters

dbmaint.log

This log contains information pertaining to the dbmaint command, which synchronizes 
the internal tables to the database schema.

install.log

This is the product installation log, which contains output from the installer process. If 
you see errors in this log, you may need to uninstall OVPI and re-install it. See also 
upgrade.log on page 17.

metrics.log

This log can be used to give a good assessment of how much data is being collected and 
how efficiently it is being collected. The log contains 12 comma-delimited fields:

• dtsys003 (at this time, all are 003 in metrics.log)

• Process Name (almost always bcp_gateway, but sometimes mw_collect)

• Process ID 

• Parent Process ID

• Start Date

• Start Time

• Total Rows (or Attempted Rows)

• Rows Uploaded

• Min Time to Load 1K Rows

• Max Time to Load 1K Rows

• Average Time

• Name of Table Uploaded
16
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report.log

There is one Package Manager log for each Package Manager session. The log contains 
output from the Package Manager report pack installation process.

Check report_YYYYMMDDhhmmss.log for messages generated during report pack 
installation.

where: YYYY is the 4-digit year from the Package Manager session.

MM is the 2-digit month from the Package Manager session.

DD is the 2-digit day from the Package Manager session.

hh is the 2-digit hour from the Package Manager session.

mm is the 2-digit minute from the Package Manager session.

ss is the 2-digit second from the Package Manager session.

trend.log

This log file contains critical information from back end processing. Key information 
found in trend.log includes the following:

• Node timeouts, problem nodes, missing collections, etc.

• Aggregation failures, overnight processing information

upgrade.log

This is the product upgrade log, which contains output from the upgrade process. If you 
see errors in this log, you may need to uninstall OVPI and perform the upgrade again.

website.log

This log contains informational, warning, error, and debug messages from the Web Access 
Server. It shows when the OVPI HTTP server was stopped and started.

Debugging must be turned on (see Debugging with the Web Access Server on page 12) 
for debug messages to appear in the log. Enabling debugging also causes SQL queries and 
other more detailed information to appear in the log.
17
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Device Issues
This chapter helps you determine if you have a device problem and, if so, to identify the 
source of the problem. For each type of device problem, one or more solutions is offered.

Symptoms

These are the most common symptoms of a device-related problem:

• No data in a report

• SNMP errors in log files

If you have either of these symptoms, use the SNMP flowchart to guide you through the 
troubleshooting process. 
19



Device Issues
Figure 1 SNMP Troubleshooting Flowchart 

For example, as shown in the flowchart, you would first try to ping the device to 
determine if it is running. 

The next sections in this chapter explain how to work your way through the SNMP 
troubleshooting process.
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SNMP Troubleshooting

Ping the Device

Ping the device to see if it is running. If you are polling by node name, ping by the node 
name and also by the IP address.

• If you cannot ping the device using the node name, but you can reach it using the IP 
address, check the server’s hosts file to verify that the name exists.

• If you cannot ping the device at all, contact your network administrator to check node 
connectivity.

• If you can ping the device, poll the device with OVPI MIB Browser to see if you can 
get an SNMP response. See Use MIB Browser to Poll Device on page 22.

Possible Solutions

These are possible solutions if you cannot ping the device.

• Restart the device.

• Make sure that the route to the device is up.

• If the device is behind a firewall, make sure that the device can be accessed.

• If the device is in a different domain, make sure that the server can access the other 
domain.
21
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Use MIB Browser to Poll Device

The illustration below shows the MIB Browser. 

In the left pane of the MIB Browser you can view the contents of the MIB database. You 
can select a MIB object (a device in this case) and then issue an SNMP GET to query the 
device. See the Performance Insight Administration Guide for more information about 
how to use the MIB Browser.

After you issue an SNMP GET to a device, the Query Results area, in the right pane of the 
MIB Browser window, displays the results. If the GET operation fails to display results, 
check the following:

• Can the specified Host name be resolved to the node’s IP address? 

• Is the device’s SNMP agent down?

• Is the specified community string correct? See Wrong Community String on page 23.
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• Is the node configured to respond to SNMP requests from your system? See Device 
Does Not Respond to Polling Server on page 23.

• If the server uses a hosts file, check this file for the node name and IP mapping.

Possible Solutions

• Try using the IP address in place of the Host name.

• Start the SNMP agent; make sure the agent comes up when the device is started up.

Wrong Community String

In the MIB Browser window, the Community field displays the device’s community 
string as it is configured in OVPI. Compare this value to the community string value in the 
SNMP agent’s configuration.

Possible Solution

If the community string values in OVPI and the SNMP agent’s configuration do not 
match, change one of them to match the other.

Device Does Not Respond to Polling Server

Check the SNMP agent configuration on the device to make sure that it is configured to 
respond to the OVPI poller.

Possible Solution

In the agent’s configuration, add the OVPI polling server to the list of acceptable devices.

Polling Times Out

Check trend.log for timeout error messages, which look similar to the following:

1 SNMP request failed. Device device_name
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If you find these error messages, run mw_collect for this table for this device from the 
command line with a longer timeout parameter (-o). If this solves the problem, use the 
solution below to make the longer timeout permanent.

Possible Solution

Modify the mw_collect command in trendtimer.sched to allow a longer timeout 
(-o).

Device Is Overloaded

If the SNMP agent has low priority on the device, it will stop answering SNMP requests 
when the network load becomes congested. This will result in “gaps” in the data reported 
from the device.

Possible Solution

Access the SNMP profile in the Polling Policy Manager for that device. Increase the 
time-out value in the SNMP profile to allow the agent more time to respond to the SNMP 
request.

Next Step

If you have tried all the solutions in this chapter and the problem is not resolved, proceed 
to Chapter 4, Report Issues.
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Report Issues
If you are having problems with your reports, this chapter will help you identify the source 
of the problem. For each type of report problem, one or more diagnostics and solutions are 
offered. 

This chapter covers the following types of report problems:

• Reports Are Not Generated on page 26

• Report Is Empty on page 29

• Device Not in a Report on page 40
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Reports Are Not Generated

If no reports appear in the batch mode output directories, there are several possible causes, 
which are listed below and discussed later in this chapter. You can investigate the causes 
in any order. If the suggested solution does not resolve the problem, keep trying other 
causes until you find the source of the problem.

• The application server is not running. See page 26.

• The desired report has not been scheduled for timed generation. See page 27.

• The report was not run in the deploy directory. See page 28.

• The report was not generated for other reasons. See page 28.

Application Server Is Not Running

Follow these steps to determine if this is the cause of the problem:

1 Open a web browser.

2 In the URL address area, type http://servername:portnumber, where servername is 
the name of the application server where OVPI is installed and portnumber is the port 
where the application server is installed. Then press Enter.

• If the OVPI login page appears, the server is running. Try restarting the 
application server anyway. If that doesn’t solve the problem, try one of the other 
solutions in this chapter.

• If another application home page (other than OVPI) appears, shut down the other 
application and restart the OVPI application server. (If you want both 
applications to run simultaneously, you must change the port number for one or 
the other. See the section on Changing Web Access Server Settings in the 
Performance Insight Administration Guide.)

• If an error page appears, the server is not running. Start the application server and 
run the report again.
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Report Is Not Scheduled

Possibly the desired report has not been scheduled for timed generation. Follow these 
steps to determine if this is the cause of the problem:

1 From the Web Access Server home page, select Schedule > Schedules > username. 

2 Make sure that the desired report is included in the schedule file by clicking the file 
name in the Schedule File column. 

3 To make sure that you can run the report manually, select the desired report and click 
Run.

• If this is successful, go to Step 4.

• If the report is not generated, this is probably not a schedule problem. Try one of 
the other causes/solutions in this chapter.
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4 Return to the previous web page and check the schedule file as follows:

• Make sure that the schedule file Status is “enabled.” If it is “disabled,” select the 
schedule file name and click Enable. 

• If the Examination Time is set to Never, do the following:

— Click the word “Never.” 

— On the next web page, click to place a check mark in the box next to Add to 
Generator Timer.

— Click Apply.

5 The next time the report is scheduled to run, check to see if it was generated.

Report Does Not Exist in the Deploy Directory

Make sure that the report has not been deleted from the relevant deploy directory:

• {DPIPE_HOME}/reports/deploy/system/report_pack_name

• {DPIPE_HOME}/reports/deploy/users/user_name

Other Reasons Reports Were Not Generated

If no reports have been generated, this log file will not exist:

{DPIPE_HOME}/log/generate.log 

Check these log files for error messages regarding report generation:

{DPIPE_HOME}/log/website.log

{DPIPE_HOME}/log/generate.log 

Research the error messages in the log file. If necessary, increase the OVPI application 
server’s heap size. See the section on Changing Java Settings in the Performance Insight 
Administration Guide.

Next Step

If you have tried all the solutions in this section and you still cannot generate the report, 
see Chapter 5, Additional Resources and Problem Reporting.
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Report Is Empty

If the desired report is generated but there is no data in it, there are several possible causes, 
which are listed below and discussed later in this chapter. You can investigate the causes 
in any order. If the suggested solution does not resolve the problem, keep trying other 
causes until you find the source of the problem.

• There is actually no data for the selected element. See page 29.

• There is no data for the selected time range. See page 35.

• A graph on a report appears to have no data. See page 36.

• The report was run before rolled-up data was ready. See page 37.

• The database was full when OVPI attempted to collect data for the report. See 
page 38.

• The disk was full when OVPI attempted to store collected data. See page 39.

• Filtering is enabled. See page 40.

No Data for Selected Element

Follow these steps to determine if this is the cause of the problem:

1 Open the problem report in Report Builder.

2 Click on any row in the report to display information about the table in the left pane.
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This shows you the name of the table to check to see if data exists for the element in 
question. In this example, the table name is SDVDevRes_Device. 

3 Start the Management Console, and select Tables from the System pane.

4 Locate the name of the table in the tree, under Data Tables, and click on it. 
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5 From the View menu, select Display Table Contents > Create New View of 
SDVDevRes_Device.

One of the following will happen:

• The displayed table will have no data, which means that there is no data for any 
device. There are many reasons that could account for this situation, for example, 
the correct datapipe may not be installed. See the User Guide for the appropriate 
report pack, that is, the report pack of which this report is a part. 

• The table will display data, which you must now filter to show only data for the 
device that you are troubleshooting. Continue with Step 6.

6 From the Query menu, select Select Nodes/Interfaces. 

To help you find the name of the table, you can do the following: in the tree, 
expand Time Type and select All. Then, in the right pane, sort the table 
names by the SQL Name column.
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The Node Wizard opens. 

7 Click Select Nodes and Interfaces Individually, then click Next.

The Select Nodes/Interfaces window displays. 

8 Click Use Selected Nodes/Interfaces, select your device from the list, then click Next. 

9 On the final wizard window, click Finish.
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10 One of the following will happen:

• The table will have no data, which means that there is no data for the device. See 
Chapter 3, Device Issues.

• The table will display data, and you must now verify the time period. Continue 
with Step 11.

11 From the Query menu, select Sort Order. 

12 Click New.

The Sort Order window displays. 
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13 Do the following:

a Under Statistic, click the drop-down arrow and select Time Period from the 
selection list.

b Click in the Sort Order column and change the value to DESC (descending), so 
the most recent data will appear at the top of the table.

c Click OK.

A table similar to the following illustration appears. 

14 Check the Time Period column. The data in the first row should be from yesterday.

• If the data is not from yesterday, this is the reason no data displayed in the report. 
You must investigate further to determine why there is no data from yesterday for 
the device. See Chapter 3, Device Issues.

• If the data is from yesterday, verify that no constraints or filtering are being used, 
which might be preventing data from appearing in the report. See Device Does 
Not Meet Report Criteria on page 40 and Device Was Filtered Out on page 42. 
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No Data for the Selected Time Range

Follow these steps to determine if this is the cause of the problem:

1 Right-click anywhere on the report. The example below shows the Near Real Time 
report. 

2 Select Set Time Period from the pop-up menu. 

3 Review the settings in the Start area of the Set Time Period window. If the settings 
are not set correctly for the polling policy that is in use, change them accordingly.

• Normally, near real time data is retained for 2 days, so, in this example, you 
would change the Start setting to Previous 2 Days for the Near Real Time 
report.
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• If you want to check time periods that are longer than 2 days, use a Daily Top 
Ten report.

4 Run the report again and see if data appears.

Follow-up

If data exists in the table for the specified time frame, the data should appear in the report. 
One of the following may be cause of the original problem:

• trendtimer is not running. Start trendtimer.

• The database is full. See Database Was Full on page 38.

• The relevant daily process has not been completed. See Report Was Run before 
Rolled-Up Data Was Ready on page 37.

• The datapipe has been uninstalled. Install the appropriate datapipe(s).

• The report pack has been uninstalled, even though the reports are still deployed. 
Install the report pack.

If data does not appear in the report, check the table indexes. Also look in 
builder.log for clues about why the query is failing.

Report Has an Empty Graph

Sometimes a graph on a report may appear to be empty. This could happen when OVPI 
has not been running long enough to collect sufficient data to be displayed in the graph or 
when the collected data is all zeroes.

Follow these steps to determine if this is the cause of the problem:

1 Open the problem report and right-click on a graph element.

2 Select Display Data Table from the menu.

If there is data for the graph, a dialog will display the data in table format. 

A device may support some metrics and not others on a single report. For example, a 
graph intended to show CPU statistics may display data while a graph intended to show 
buffer statistics is empty. Check the report pack’s release statement and user guide to 
determine which metrics are supported by each type of device.
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Report Was Run before Rolled-Up Data Was Ready

Follow these steps to determine if this is the cause of the problem:

1 Open {DPIPE_HOME}/lib/trendtimer.sched. 

24:00+3:00 - - …/trend_proc -f {DPIPE_HOME}/scripts/
IR_RouterSystem_Process.pro

24:00+3:00 - - …/trend_proc -f {DPIPE_HOME}/scripts/
IR_DevPort_DMF_Process.pro

24:00+4:00 - - …/trend_proc -f {DPIPE_HOME}/scripts/
IR_Device_DMF_Process.pro

24:00+4:00 - - …/trend_proc -f {DPIPE_HOME}/scripts/
IR_Protocol_DMF_Process.pro

24:00+4:00 - - …/trend_proc -f {DPIPE_HOME}/scripts/
IR_Location_DMF_Process.pro

2 Locate the line that shows what time trendtimer is scheduled to launch the data 
roll-up process. For example, in the sample above, IR_RouterSystem_Process.pro is 
scheduled for 3:00 a.m.

3 Open {DPIPE_HOME}/log/trend.log. 

trendtimer(193): Fri Aug 17 03:00:07 2003  - [Pid=444] 
C:\TREND/bin/trend_proc -f C:\TREND/scripts/
IR_RouterSystem_Process.pro

. . .

trendtimer(193): Fri Aug 17 03:04:09 2003  - Process (id=444) 
terminated. 242 sec.

4 Find the matching process IDs to locate the beginning and termination of the roll-up 
process. In the sample above, PID 444 started at 3:00 a.m. and ended at 3:04.

5 Open {DPIPE_HOME}/lib/trendtimer.sched and check the system 
schedule to determine when the report was generated. In the example below, the 
report generation time is 4:00 a.m.

24:00+4:00 - - {DPIPE_HOME}/bin/generate.exe -user trendadm 
-pass trendadm -host localhost -port 80 -schedule system -log 
{DPIPE_HOME}/log/generate.log
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• If the time that generate.exe was launched is after the time of data roll-up, 
the problem is not in the timing of the roll-up process. Try one of the other 
diagnostics in this chapter.

• If the time that generate.exe was launched is before the time of data roll-up, 
the problem may be in the timing of the roll-up process. Go to Step 6.

6 Modify the schedule file so that the report is generated after data roll-up is completed.

7 The next time the report is scheduled to run, see if data appears.

Database Was Full

There are two ways to determine if the database was full when OVPI attempted to collect 
data to populate the report:

• Check trend.log.

• Check Table Manager.

Check trend.log

1 Open {DPIPE_HOME}/log/trend.log. 

2 Look for an entry that indicates that mw_collect.exe was started, followed by a 
warning that the database was full, as in the first two entries in the sample below.You 
will then see a third entry indicating that data collection was terminated, also shown 
in the sample.

trendtimer(150): Thu Jul 10 01:05:00 2003 - [Pid=360] 
C:\TREND/…/mw_collect.exe -n -i 5

mw_collect(360): Thu Jul 10 01:05:00 2003  - Warning: 
database CLASS100 is 91% full.

mw_collect(360): Thu Jul 10 01:05:00 2003  - Collection is 
terminated

3 Do one of the following to improve the database situation:

• Increase the size of the database.

• Modify your storage hardware/software resources to accommodate more data.
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Check Table Manager

1 Start the Management Console, and select Tables from the System pane.

2 Select Statistics from the Database Table Management tree. 

3 Check the value in the Free (MB) column.

If this value is greater than the high water mark for any data creation process, no new 
data will be added to the database.

4 Do one of the following to improve the database situation:

• Increase the size of the database.

• Adjust the polling frequency by decreasing the polling interval.

Disk Was Full

If the disk or filesystem where mw_collect stores its collected data is 90% full, OVPI 
stops collecting data. Follow these steps to determine if this is the cause of the problem:

1 Open {DPIPE_HOME}/log/trend.log. 

2 Look for an entry similar to the following:

2005-04013 15:56:53:000,Eastern Daylight Time,-4:00, 
mw_collect,,WARNING,3276,4392,0,”Warning: C:\OVPI\collect\MW 
has less than 10% space left. Collection is terminated.

3 Do one of the following to improve the situation:

• Clear some space on your disk drive or filesystem.

• Change the entries in trendtimer.sched to enable mw_collect to use the 
-F option.
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Filtering Is Enabled

Follow these steps to determine if this is the cause of the problem:

1 In the Web Access Server, select Administration > User Accounts > Users/Groups.

2 Check to see if the user having problems is in a group-level filter. 

• If so, go to step Step 3.

• If not, try one of the other diagnostics in this chapter.

3 Run the report as a user who is not a member of a group-level filter.

Next Step

If you have tried all the solutions in this section and the report is still empty, see Chapter 5, 
Additional Resources and Problem Reporting.

Device Not in a Report

If the desired report is generated but a device you expected to see does not appear, there 
are several possible causes, which are listed below and discussed later in this chapter. You 
can investigate the causes in any order. If the suggested solution does not resolve the 
problem, keep trying other causes until you find the source of the problem.

• The device does not meet the criteria to appear in the report. See page 40.

• The device was not polled. See page 42.

• The device was filtered out of the report. See page 42.

• The device does not support the MIB. See page 43.

Device Does Not Meet Report Criteria

The device may be omitted because it did not meet a particular constraint value. Follow 
these steps to determine if this is the cause of the problem:

1 Open the problem report in Report Builder.
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2 Click on any row in the report to display information about the table in the left pane. 

3 In the tree, expand Data > Query > Constraint List. 

The tree lists all the constraints associated with the report.

4 Delete each constraint, as follows:

a Right-click on the constraint name in the tree.

b In the menu that displays, select Delete Constraint.

5 Refresh the report.

If the device now appears in the report, it means that it previously did not meet the 
constraint criteria.

6 If you want to save the report without the constraints, save it using a unique report 
name.
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Device Was Not Polled

The device may be omitted because it is not in the group that is being polled. Perform the 
following steps to determine if this is the cause of the problem:

1 Execute a Type Discover, using one of the following methods:

• Execute this command: trend_discover -t

• To save time, you can execute this command, if you know the specific discover 
file to use: trend_discover -t -F discover_filename

• From the Management Console, select Tools > Type Discovery. Select the 
Discovery file you want to use or click Discover All Known Types, then complete 
the wizard.

2 Wait at least three polling cycles to see if data for the device appears in the report.

If the device does not appear in the report after several polling cycles, ping the device to 
be sure that it is running and connected to the network. (See Ping the Device on page 21.) 
If you can connect to the device using SNMP, try one of the other procedures in this 
section.

Device Was Filtered Out

The device may be omitted because the user running the report is a member of a group 
that filtered the device out. Only the system administrator can view the groups to which a 
user belongs, so you may need to ask for the administrator’s help to do this check.

1 From the Web Access Server home page, select Administration > User Accounts > 
Groups.

2 On the Group Administration window, click on the name of the group of which the 
user is a member, then click Edit Filter.

The filter information for the group appears.

3 The administrator should now determine if the device is being filtered out and do one 
of the following:

• If the device is being filtered out, the administrator should add the device to the 
user’s group. This will enable the user to see the device in reports.

• If the device is not being filtered out, the administrator should follow the 
procedure in No Data for Selected Element on page 29.
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Device Does Not Support the MIB

If you have executed a Type Discover, and the device was not discovered, the device 
probably does not support the MIB object you are testing against. Review the release 
statements for the relevant datapipes to get a list of the MIBs that are supported by the 
datapipes. Then verify that the device supports at least one of these MIBs.

Next Step

If you have tried all the solutions in this section and the device still does not appear in the 
report, Chapter 5, Additional Resources and Problem Reporting.
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Additional Resources and Problem 
Reporting 
This chapter serves two purposes:

• It points to resources that you can use to attempt to solve problems before calling HP 
Technical Support.

• It describes the process of requesting assistance from HP Technical Support when you 
have exhausted the resources provided in this guide.

Additional Resources

This section describes resources that may help you resolve your problem without 
contacting HP Technical Support.

Documentation

In addition to this guide, the OVPI documentation set includes the following guides:

• HP OpenView Performance Insight Administration Guide 

• HP OpenView Performance Insight Guide to Building and Viewing Reports 

• HP OpenView Performance Insight Installation Guide 
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• HP OpenView Performance Insight Reference Guide 

• HP OpenView Performance Insight Release Notes

To view OVPI documentation, go to the Support web site at this URL:

http://managementsoftware.hp.com/services 

Do the following:

1 Click Product manuals under the heading “Using our products.” 

The Product manuals search window opens. It is located at: 

http://ovweb.external.hp.com/lpe/doc_serv/ 

2 In the Product list, click Performance Insight. 

3 In the Version list, click 5.1. 

4 In the OS list, click the operating system used. 

5 Select the Product manual title, and then click Open or Download. 

In addition to customizing existing reports and learning how to create your own reports, 
you also might want to explore advanced features that allow you to integrate OVPI with 
other systems and import data from other sources. Procedures for using these more 
advanced features are found in the following guide: Performance Insight TEEL Reference 
Guide. You can obtain this guide by attending OVPI customer training. For information, 
call your HP sales representative or go to:

http://www.hp.com/education/courses/u7380s.html

Software Support Online

The Management Software Support web page provides a variety of resources, including 
the following:

• Self-solve knowledge search

• FAQs

• Software patches

• Information about training and education

It also includes a link to the Software Support Online User’s Guide, which explains how to 
report a problem online. The guide also explains how to obtain an HP Passport, which is 
required to access some of the resources on the Support web page.
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Patch Web Pages

You can download the latest OVPI-related patches (service packs) from the HP Support 
web site, as explained in the following procedure. 

1 Go to the Support web page at this URL:

http://managementsoftware.hp.com/services

2 Click Software patches.

3 Do one of the following:

• For Performance Insight patches, select Performance Insight from the product 
list.

• For Reporting and Network Solutions (report packs) patches, select 
Performance Insight Reporting Solutions from the product list.

Self-solve Knowledge Search

You can search the HP Software Support knowledge database for information about a 
problem.

1 Go to the OpenView support web page at this URL:

http://managementsoftware.hp.com/services 

2 On the top navigation bar click Sign-in with HP Passport.

3 Do one of the following:

• Enter a question, phrese, keyword, or document ID.

• Click Advanced Self-solve knowledge search. (We recommend this option, because 
it allows you to refine your search.)

4 On the Advanced Search window, enter information that enables the utility to search 
for the precise information you want.

5 Click Search.

The results depend on the nature of your search. For example, if you selected Known 
problems you would see different information than if you selected Technical documents.
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Other Tools

OVPI includes a support tool called selfmonitoring.pl, which formats the data in 
some of the log files to make it easier to interpret. The tool queries the OVPI audit and 
trend logs to produce a readable report about the health of the OVPI server. 

You can run this script on any OVPI server that contains trend and/or audit logs. The 
script is located in the $DPIPE_HOME/contrib/support directory on OVPI 5.0 and 
later systems.

For instructions on using this tool, see the README documentation located in 
$DPIPE_HOME\contrib\support\README.pdf.

Reporting a Problem

If you have not been able to resolve your problem using the information in the preceding 
chapters or the resources described above, you should contact HP Technical Support. This 
chapter describes the steps you should perform in order to make a support call or open a 
case online. 

• Gather required information

• Prepare to answer additional questions

• Provide log files

• Contact HP Technical Support

Gather Required Information

Before you contact HP Technical Support, gather the following types of information, 
which are critical in diagnosing the problem:

• Any changes that occurred before the problem occurred, for example, new software 
or hardware installed

• Sequence of events that led up to the problem

• Steps already taken to resolve the problem 

• OVPI software version (found in $DPIPE_HOME\data\version.prp)
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• List of OVPI service packs that are installed (found in 
$DPIPE_HOME\data\version.prp)

• Operating system type and version running on the machine where OVPI is installed

• Database type (Sybase or Oracle®) and version

• List of installed OVPI report packs and their versions

To determine which report packs are installed, follow these steps:

a Log in to the database.

b Type the following commands:

select app_name, install_date, version

from dsi_reporting_apps

where status = ‘installed’

go

• If the problem is with the Web Access Server, Report Builder, or Report Viewer, and 
if the problem is reproducible with an .srep file, include the .srep file. See the 
information on displaying and saving table data in the Performance Insight 
Administration Guide.

Prepare for Questions

Be prepared to answer the following questions, which the support representative may ask:

• Is this a new installation of OVPI, or have you been running OVPI in a production 
environment for a period of time?

• Who performed the installation?

• Who are the system and network administrators for the machine where OVPI is 
installed? (The support representative may need to talk to the system or network 
administrator to solve some problems.)

• What other programs are running on the OVPI machine?

• Is this a distributed installation?
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Provide Log Files

Although HP Support may not require all the log files, it is best to zip (or tar) the entire 
OVPI logfile directory ($TREND_LOG or $DPIPE_HOME/log/) and send it with your 
other problem documentation. 

Contact HP Technical Support

You can report a problem by telephone or on the HP OpenView web site.

Problem Reporting by Telephone

You may use this toll-free telephone number to contact HP Technical Support:

800-633-3600

Problem Reporting on the Web

To report a problem on the HP web site, you must have an HP Passport user ID and 
password. Follow these steps to report a problem on the web:

1 Go to the OpenView support web page at this URL:

http://managementsoftware.hp.com/services 

2 Under Problem Reporting, click Submit support case.

3 On the HP Passport page, enter your user ID and password and click Sign-in.

4 Enter the information required to describe the problem, provide contact information, 
etc.

5 Click Next.

6 Review the summary of the information you entered, then click Submit Case.

You will receive a confirmation email message that will specify your support case ID. You 
can reply to this message if you need to send related files to the support team.

If you use the HP Support web site to open a case, you have the option of uploading log 
files to an ftp site. The files are then automatically attached to the case. 
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